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MODULES 
 

Class – IX 

April/May 

Open office .org writer I 

Report file 

Poster Making – Global Warming  

July 

Open office .org writer II 

 Report file 

Mail merge – formal / Informal letter 

August 

Open office .org calc I 

Report file 

School / Class result with Student-wise and Subject-wise marks 

Cricket Score record  

September: SA1 

Project Work: Open office .org writer I, Open office .org writer II & Open 

office .org calc I. 

October 

Open office .org calc II 

Report file (Chart) 

School / Class result with Student-wise and Subject-wise marks 

Cricket Score record 

November 

Open office .org impress   

Report file   

School magazine / Environment and pollution  

December 

Flash 

Report file 

 Movement of ball with help of tweening  
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January 

Photoshop 

Report file 

Bouquet of flowers  

February 

Revision 

 

March –SA-II 

Flash, Photoshop , Open office .org calc II, Open office .org impress. 
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FLASH 

Macromedia Flash is a professional standard tool used to produce high-impact web 

pages and web sites that includes a good amount of animation, sound, graphics 

and interactivity. The extension of a Flash file is .fla 

 

To open the flash window, perform the following steps: 

1. Click the start menu.   

2. Go to Programs. 

3. Click at Macromedia Flash. 

4. Click Flash. 

The following screen appears: 

 

 

 

The white rectangular area within the window is called the Stage or Workspace. 

Any graphics placed in this area will be visible to the user. On the left side of the 

window appears the toolbox that contains all the drawing tools in Flash. 

 

As the Flash window is opened, an unsaved document appears called as Movie 1. 

A Flash movie is further divided into number of Scenes. 

 

A Scene can be considered as a chapter in a book. The advantage of breaking a 

movie into scenes is, every scene can be accessed individually and thus the 

sequence or order of the scenes can be changed. The default name of the first 

scene of the movie is Scene 1. 

 

Every scene can be further divided into Layers, which can be considered as a topic 

in a chapter. Images or text can be stored in the form of layers so that the 

animations can be controlled independently. 

 

Every image in the Layer is called a Frame. The frames are the little rectangular 

cells, which are numbered. The contents of only one frame can be seen at a time. 

The red marker on the frame indicates the frame that is currently viewed. 
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Toolbars 

Toolbars are seen on the left side of the flash window, which are used to create 

graphics and text. If the tools are not visible, then use Window<Tools Option. 
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Lets see briefly, what some of the commonly used toolbars do: - 

•  The Line and the Pencil tool are used to draw lines. 

•  The Oval tool is used to draw ovals and circles. 

•  The Rectangle tool is used to draw squares and rectangles. 

•  The Ink Bottle tool changes the color of the lines, which is to be clicked 

anywhere on the shape and only the line portion changes. 

 

•  The Brush tool and the Paint Bucket tool are used to fill any enclosed area with 

some color. 

 

•  The Pen tool is used to draw straight and curve lines. 

•  The Text tool is used to create text. The text created can be modified, that is, the 

font; color and style of the text can be changed at any point of time. 

 

•  The Arrow tool and the Subselect tool are used to select an object by clicking it 

once. If you click and drag an image using the arrow tool, then only the filled 

portion of the image moves and not its border. To make the border also move 

(i.e. the complete image) double-click inside the image and then drag it. This 

tool is also used to change the shape of the image. To do so, move the cursor 

near the outside edge of the image and the cursor will change and then you 

drag it to give it an appropriate shape. 
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•  The Dropper tool lets the user choose a color already existing on the screen and 

use it elsewhere. To do so, click the dropper tool, keep it on the sample image 

and click it. The Paint Bucket tool becomes active if the dropper tool is kept 

inside the image while the Ink Bottle tool becomes active it the dropper tool is, 

kept on the border of the image. 

 

•  The Lasso tool is used for freehand selections, so that any part of the object can 

be selected. 

 

Panels 

On the right hand side of the flash window appears the panels which allow the 

user, to change the properties of the objects. 

 

Some of the important panels are: 

(a)  Fill Panel: This panel allows the user to change the color of the painted 

object. To open this panel, select Window < Color Mixer. 

 

(b)  Info Panel: Appearance of the object (image/text) can be changed through 

this panel. That is, height and width of the object can be 

changed. To open this panel, select Window < Info. 
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LAYERS AND FRAMES 

There are three types of layers in flash: 

 Normal layer 

 Guide / Guided layer  

 Mask / Masked layer 

Normal Layer: It’s the default layer this layer guides the path to the other layers. 

The layer is made the guide layer by selecting the layer properties (Modify < 

Timeline< Layer properties) and choosing the Layer type option as guide. 

 

Guide / Guided layer  

The layer that will follow the path provided by the guide layer will be called as 

Guided layer. 

Note that the Guided layer do not appear in the Flash Movie. 

 

Mask and Masked Layer: This layer lets you place any shape or symbol that will 

define the visible or non-visible portion of the layer below it. The graphical contents 

of the mask layer will determine which portion of the layer below it will show 

through. A layer is selected as a mask layer by going to the layer properties and 

selection mask option. The layer below the mask layer is the masked layer. 

 

For example, if you draw a filled circle in the mask layer and a number of colorful 

boxes in the masked layer, then the content of the masked layer will be shown 

through the circle made in the mask layer, of course, depending upon the path the 

mask layer will follow. 

 

Layer Properties 

All layers can be controlled through some properties associated with them. To open 

the Layer property dialog box, do any of these: 

 

•  Right click on the layer name and select properties. 

OR 

•  Click the Modify option from the Menu bar and select layers.  

To change the property of any layer, it should be selected. To select a layer, click 

on the layer name. A pencil icon will appear near the layer name, which indicates 

that the layer is selected and can be modified. 

 

Adding a Layer 

• To insert a layer, go to the Insert menu on the Menu bar and select Layer. 
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OR 

• Right Click on any Layer and select Insert Layer. 

Deleting a Layer 

• Right Click on the Layer and select Delete Layer. 

 

FRAMES 

Concept of Frame 

Animation, is made from individual images. Actually, animation is a collection of a 

number of still images at different locations. But the transition from one image to 

another is so fast that everything appears to be moving. Every image in animation 

is called a Frame. 

 

To Insert a frame: 

 Go to the Insert menu on the Menu bar and select timeline then frame. 

OR 

 Right Click the mouse button on the frame number and select the option 

Insert frame 

 

To Delete a frame: 

 Right Click the mouse button on any create frame number and select the 

option Remove frame. 

 

Note that the last frame will be deleted. 

To Copy a frame: 

 Select the frame number to be copied, right click the mouse button and select 

the option Copy frame. 

 

To Paste a frame: 

 To paste the frame, select the frame number when the frame is to be pasted, 

right click the mouse button and choose the option Paste frame. 
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Note:  To select more than one frame, just click at the starting frame and drag 

till the end frame and you can perform the option like Delete frames for 

all the frames selected. Thus, all the frames selected will be deleted at 

once. 

 

Keyframe and Blank Keyframe 

A Keyframe is simply a frame in which the user can indicate the change at a 

particular point. That is, a keyframe indicates either the change in the image 

appearance or its position on the screen, so through a keyframe, you can indicate 

what should appear on the screen at a particular point. A keyframe might include 

an image or it might be blank. A Blank Keyframe is also a keyframe, but it's the one 

in which nothing appears on the screen. 

 

To insert a Keyframe/ Blank Keyframe: - 

 Choose a frame by clicking it, go to the Insert menu on the Menu bar and 

timeline choose the option Keyframe. If no image is present in the layer, then 

a blank keyframe is inserted. 

OR 

 Choose the frame, click the right mouse button and select the option Insert 

keyframe. To insert a Blank Keyframe select the option Insert Blank keyframe 

by clicking the right mouse button. 

 

A keyframe when created will be indicated by either a white square or a solid 

circle. The contents for the keyframe are copied from the previous keyframe and 

if there is nothing on the previous keyframe, then a blank keyframe is inserted. 

Thus, if an image or an object is present in the previous keyframe, then that 

image or object will be copied to the new keyframe. If you click at any frame 

within the two keyframes, then the contents of the previous keyframe will be 

seen. 

 

To Delete a Keyframe/ Blank Keyframe: 

 Put the red marker on any of the created frame number, go to the Insert 

menu on the Menu bar and select delete frame. 

 

OR 

 Right Click the mouse button on any create frame number and select the 

option Delete frame. 

Concept of a Symbol 

Flash provides the facility to store the objects (i.e. images and text) in a place called 
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Library. Everytime a symbol is selected from the library to be used in the movie, its 

copy is used and this copy of the symbol is called as the Instance. 

 

MOTION, SHAPE TWEENING 

Flash provides you the facility to show the transition of the image from one 

keyframe to another keyframe. This transition is called as Tweening. 

 

Through tweening, the user can not only see the transition from one image to 

another in terms of its shape but also in terms of its motion. For example, through 

tweening you can show a ball bouncing or moving vertically or horizontally or 

showing the change in the color of the text slowly, etc. 

 

Flash has two types of tweening: 

1. Motion Tweening 

2. Shape Tweening 

Motion Tweening: It is used to tween the text/image in terms of its:  

Position (i.e. to show the object moving from one place to another), 

Scale (i.e. to show the change in the size of the object), 

Rotation (i.e. to show the change in the angle of the object), 

Color (i.e. to show the change in the color of the text/image in terms of making the 

object light/bright, etc.) 

 

Motion Tween works only on symbols and will not work oh layers, which contain 

more than one symbol. Shape modification is not allowed in motion tweening.  

 

Shape Tweening: Shape Tweening is used when the change in the shape of the 

object is required to be shown. For example, shape tweening can be used to show 

the conversion of a circle to a semicircle. Shape Tweening doesn't work on 

symbols. 

 

========================================== 
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PROJECT WORK 

 

Answer the following questions: 

1.  What is the difference between a Frame and a Keyframe? 

2.  What is the extension of a Flash file? Why do we need .swf file? 

3.  Why tweening is required in animation? 

4.  What is the difference between a Keyframe and a Blank Keyframe? 

5.  Why we use flash? 

6.  Explain the following terms: Stage, Scene, Layers and Timeline. 

7.  Differentiate between Ink Bottle Tool and Paint Bucket Tool. 

Lab Work: 

 

1. Make a ball and convert it into smiley using tweening.  
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PHOTOSHOP 

INTRODUCTION 

Photoshop is a software for image processing. It is widely used by professional 

photographers to edit, manipulate and recolour photographs and create special effects 

draw objects, write text on them. 

 

STARTING PHOTOSHOP 

To start Photoshop, follow the given steps: 

Step-1  Click Start button – All Programs. 

Step-2  Click Adobe Photoshop. 

 

TOOL PALETTE 

The tools palette contains tools to draw, paint, and erase. There are four categories of 

tools in Photoshop’s Tools palette: 

 

 Selection Tools  

 Path, Text and Shape Tools  

 Painting Tools  

 View Tools 
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CREATING A NEW FILE 

To create a new Photoshop image file, follow the given steps: 

Step-1) Click on File menu. 

Step-2)  Click on New option. 

Step-3)  In the New dialog box that appears, specify the details (Name, Size, 

Resolution, Background Contents, Color Mode) and click on OK button. 

 

A new blank image file is created. Now, you can use the tools and create your own 

drawing. 

 

SAVING FILE 

To save your file follows the given steps: 

Step-1) Click on File menu  Click on the save option  The Save As dialog box 

appears 

Step-2)  Give the name to the file and Click on the Save button. 

OPENING AN EXISTING FILE 

Now you can open any existing file or any other saved image in Photoshop. 

To open an image, follow the given steps: 

Step-1) Click on File menu. Click on the open option.  

Step-2)  In the Open dialog box, select the file to open. 

Step-3)  Click Open button. 

CLOSING A FILE 

To close a Photoshop file, click File menu  close. 

EXITING FROM PHOTOSHOP 

To exit from Photoshop, click File menu  Exit. 

USING PHOTOSHOP TOOLS 

Marquee Tools 

The Marquee tools are used to select any image. 

To select an area of the image, follow the given steps: 

Step-1)  Open the image and right-click on Marquee Tool. Now, select one of the 

following shapes from the list. 

 Rectangular Marquee Tool   

 Elliptical Marquee Tool  

 Single Row Marquee Tool    

 Single Column Marquee Tool  

Step-2)  Drag the mouse over the image to get the selection. 
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Lasso Tools 

The Lasso Tools are used to make Freehand, Polygon and Magnetic selection. 

To select an area of the image, follow the given steps: 

Step-1)  Open the image and right-click on Lasso Tool. Now, select one of the 

following shapes from the list. 

 Lasso Tool  

 Polygon Lasso Tool  

 Magnetic Lasso Tool 

Step-2)  Drag the mouse over the image to get the selection, and release the mouse 

when the image or part of the image is completely selected. 

Move Tool 

The Move Tool is used to move a selected image from one location to another. 

To use Move Tool, follow the given steps: 

Step-l)  Open the image and select the part of the image using anyone of the 

selection tool. Here, it is Rectangular Marquee Tool. 

Step-2)  Click on the Move Tool. 

Step-3)  Place the mouse pointer on the image to move and drag the selected image 

to another location. 

 

Magic Wand Tool 

The Magic Wand Tool is used to select an adjacent area of the same colour in an image. 

To use the Magic Wand Tool, follow the given steps: 

 

Step-1)  Open the image and click on the Magic Wand Tool. The shape of the mouse 

pointer changes to a Magic Wand. 

Step-2)  Click on any part of the image to select all adjacent areas of pixels having 

the same colour. 

 

Crop Tool 

Cropping is the process of removing some part of an image and to create focus on the 

remaining part. 

To use the Crop Tool, follow the given steps: 

Step-1)  Click on the Crop Tool 

Step-2)  Drag over the part of the image you want to crop. Now, to complete the 

crop, press Enter key. You see the selected image gets cropped. 

 

Brush Tool 

The Brush Tool paints with smooth edges. To use Brush Tool, follow the given steps: 

Step-l)  Click the Brush Tool 

Step-2)  Choose Brush Preset (size, style) from Options bar. 
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Step-3)  Click or drag over the image to draw strokes. 

Eraser Tool 

This tool is used to erase a part of an image. To erase, follow the given steps: 

Step-1)  Click on Eraser Tool and select the type of eraser from the list : 

 Eraser Tool  

 Background Eraser Tool 

 Magic Eraser Tool 

Step-2)  Click and drag the mouse over the image to erase. 

Paint Bucket Tool 

The Paint Bucket Tool is used to fill or paint an entire selection. 

To use Paint Bucket Tool, follow the given steps: 

Step-l)  Click on the Paint Bucket Tool. 

Step-2)  Choose the colour from Color Palette and click anywhere on the canvas to 

coat the canvas with the colour. 

Type Tool 

Type Tool is used to add text in a Photoshop file. To add text, follow the given steps: 

Step-l)  Click the Type Tool. 

Step-2)  Click inside the canvas and type the text. Once your text is entered, you can 

change the font style, size, colour, bold, underline, italics, etc. using the 

Options bar. 

 

Retouching Tools 

Tools that help in editing an image are referred as the Retouching tools. These tools 

can be used on the complete image or on a selected part of the image. 

 

Let us discuss two commonly used Retouching tools. 

Spot Healing Brush Tool 

This tool helps to fix image imperfections such as scratches, blemishes, dark spots, etc. 

To use Spot Healing Brush Tool, follow the given steps: 

Step-1)  Open the file to be edited and select Spot Healing Brush Tool . 

Step-2)  Choose a brush size from the Options bar. 

Step-3 )  Click over the spots to fix imperfections in the image . 

Healing Brush Tool 

This tool also helps to fix imperfections but is different from the Spot Healing Brush tool 

as it requires to make a selection or define a source point before using it. 

 

To use Healing Brush Tool, follow the given steps: 
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Step-l)  Open the file to be edited and select the Healing Brush Tool. 

Step-2)  Choose a brush size from the Options bar. 

Step-3)  Press Alt key and click on the image to define a source point. 

Step-4)  Click over the image to fix imperfections in the image. 

Clone Stamp Tool 

The Clone Stamp Tool is used to create a duplicate copy of one part of an image over 

another part of the same Image. 

 

To use Clone Stamp Tool, follow the given steps: 

Step-1)  Open the image and select Clone Stamp Tool. 

Step-2)  Use Alt key and click to define a source point. 

Step-3)  Drag the mouse at the place where the clone is to be created. 

COPYING AND PASTING SELECTION 

Copy and Paste option is used to copy the selected part of the image to other location. 

To copy and paste, follow the given steps: 

Step-1)  Select a part of an image using any of the selection tool. 

Step-2)  Click Edit Menu  Copy option. 

Step-3) Create a new file using File  New. 

Step-4)  Now, click Edit Menu  Paste option. 

LAYER 

Photoshop layers are like transparent sheets stacked on top of each other to create the 

final image. You can change one layer without affecting the other layers or the 

background of the image. Layers create larger files but separate portions of the image, 

therefore making the work easier. 

The layer palette shows a small thumbnail view of image in the layers palette. 

CREATING A NEW LAYER 

A new layer is created when you paste any object in your in your image. 

To create a new layer, follow the given steps: 

Step-1)  Click the Layer menu, select New  click the Layer option. The New Layer 

dialog box appears. 

Step-2)  In the Name text box, type the desired name. Click OK. 

RENAMING LAYER 

To rename a layer, follow the given steps: 

Step-1)  Select the layer from Layers palette and click Layer Properties from the 

Layer menu 

Step-2)  In the dialog box that appears, type a new name for the layer and click OK. 
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DELETING A LAYER 

To delete a layer, follow the given steps: 

Step-1)  Select the layer you want to delete from Layers palette and click Layer Menu 

 Delete  Layer option. 

Step-2)  In the confirmation dialog box that appears, click Yes. 

HIDING AND SHOWING A LAYER 

To hide a layer, click on the eye icon that is the foremost left column of the layers 

palette. 

 

To show a layer, click in the leftmost column to bring back the eye icon. 

The order of the layers affect the image displayed. 

MERGING LAYERS 

Merging layers means to combine the visible layers into a single layer. 

To merge different visible layers, click Layer menu Merge Layers option. 

FILTERS 

Filters help to give special effects to the picture or selected portion of it. 

Types of Filters 

There are 11 main categories of filters in Photoshop: 

 Artistic 

 Blur  

 Brush Strokes 

 Distort 

 Render 

 Stylize 

 Noise 

 Sharpen 

 Texture 

 Pixelate 

 Sketch 

 Video 

To apply a filter, follow the given steps: 

Step-1)  Open the image. 

Step-2)  Choose any category from Filter menu. If a dialog box appears, click OK to 

see the effect. 

Filter Gallery 

The Filter Gallery helps you to apply filters and view the thumbnail image of the 

change that appears, which you may accept by clicking OK. 

 

Step-1)  Click on Filter menu and choose Filter Gallery. 

Step-2)  Choose the filter type from the gallery. 

Step-3)  Click OK to apply the filter. 

========================================== 
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PROJECT WORK 

 

Answer the following questions: 

1.  What is Photoshop? 

2.  What are retouching tool? 

3.  How do you hide a layer? 

4.  Write the steps to use healing brush tool? 

5.  How do you apply filter to an image? 

6.  Open an image of flowers and use the Magic Wand tool to select one flower. 

Use this selection to make a bouquet of flower by pasting on new image file with 

black background. 

 




